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Introduction

IndigoSCADA is a powerful SCADA useful for small scale projects where MODBUS,
DNP3, OPC DA 2.05, OPC UA 1.03, IEC 60870-5-101, IEC 60870-5-103, IEC 60870-5-
104, MQTT 3.1.1/Sparkplug B, IEC 61850 has to be used.

Features
IndigoSCADA has grown many important features during years:
d Use of data to generate daily/weekly/monthly management reports
. Historical and real time graphical presentation of data
. Real-time event and alarm notification
. Integrated real time and historical databases
. SQL editor allows for on-line maintenance of real-time and historical
databases
. Multiple users with different access rights

. Built in IEC 60870-5-101 data types

. Small footprint SCADA system

. Support of multiple dedicated lines on the back end

. OPC DA 2.05, DNP 3.0, Modbus, MQTT 3.1.1/Sparkplug B,
. IEC 60870-5-101/103/104, IEC 61850

d Softlogic programming with C scripts

. Easy Backups

. Support of multiple HMI windows

d HMI designer

Known problems and limitations

None at the moment

Introduction 5



Hardware requirements

To work with IndigoSCADA, you need a PC or a laptop with the following minimum
specifications:

Operating system Minimum requirements
Processor RAM Graphics

MS Windows Professional | 800 MHZ 512 GB XGA 1024 x 768 16-bit

XP color depth

MS Windows Server 2003 2.4 GHZ 1 GB XGA 1024 x 768 16-bit
color depth

MS Windows Vista 1 GHZ 1GB XGA 1024 x 768 16-bit
color depth

MS Windows Seven 1 GHZ 1GB XGA 1024 x 768 16-bit
color depth

MS Windows 10 - 64 bit 1 GHZ 4GB XGA 1024 x 768 16-bit
color depth

MS Windows 11 - 64 bit 1 GHZ 4GB XGA 1024 x 768 16-bit
color depth

You also need
* Keyboard and mouse
e RS232 serial interface




Software requirements

IndigoSCADA is a 32-bit (Win32) application whose functionality has been designed
especially for the following operating systems:

Microsoft Windows 2000 Professional 32-bit

Microsoft Windows XP Professional 32-bit with Service Pack 3
Microsoft Windows Vista Home Premium 32-bit with Service Pack 2
Microsoft Windows Vista Business 32-bit with Service Pack 2
Microsoft Windows Vista Ultimate 32-bit with Service Pack 2

Microsoft Windows Server 2003 Standard Edition 32-bit with Service Pack 2
used as a workstation computer

Microsoft Windows 7 Ultimate/Enterprise 32-bit
Microsoft Windows 7 Professional 32-bit
Microsoft Windows 10 64-bit

Microsoft Windows 11 64-bit

VMWare support for virtual machines (for more details, see the next chapter)

IndigoSCADA has not been tested for the following operating systems:

Microsoft Windows XP Professional 32-bit without Service Pack or with Service
Pack 1 or Service Pack 2

Microsoft Windows Vista Home Basic 32-bit

Microsoft Windows Vista variants 32-bit without Service Pack or with Service
Pack 1

Microsoft Windows Server 2008 32-bit as a workstation computer

Microsoft Windows 7 Ultimate/Enterprise and Professional 32-bit with Service
Pack 1

If you use these operating systems with IndigoSCADA, use it is at your own
risk.

Virtual Environment

IndigoSCADA can be used with these popular virtualization software:

VMware Workstation
WMware Player

VirtualBox

Software requirements



Installation

Installation of IndigoSCADA over existing IndigoSCADA
Installation

It is not recommended to install IndigoSCADA over an existing installation because
some previous installed files may conflict with newer files.

Please uninstall an existing installation of IndigoSCADA before installing a new
software version.

Installation of IndigoSCADA from setup files

Please note the following restrictions and recommendations:

» Before starting the installation or update, please close all applications (such as
Microsoft Word) that may interfere with the installation

To start the installation of IndigoSCADA, double-click the setup.exe file that you
downloaded from the Sourceforge site. Usually its name will be in the form of
indigo-scada-binaries-XX-XX-XXX-YY-YY-revZZZ.

The IndigoSCADA setup program guides you through the installation. Follow the on-
screen instructions of the setup program:

Then Accept the license pressing the I Agree button and choose as destination folder
C:\ (the default installation directory)

§ indigo-scada-binaries-07-08-2014-10-52-rev256 S¢ =10 x|
License Agreement —
Please review the license terms before installing (4}

indigo-scada-hinaries-07-08-20 14-10-52rev256,

Press Page Down to see the rest of the agreement.

The Software and documentation are Copyright 2002 to 2014 Enscada Limited and its ﬂ
licensees. All rights reserved,

This license agreement (“Agreement”) is a legal agreement between you,

("Licensee™) and Enscada Limited ("Licensor™), for use of Licensor's

distribution of IndigoSCADA ("Software™). By downloading

the Software electronically, installing, copying, or otherwise using the

Software, Licensee agrees to be bound by the terms and conditions of this

Agreement, if Licensee does not agree to the terms and conditions of this

agreement then do not download the Software, install or use the Software, and
|immediately destroy the Software. j

If you accept the terms of the agreement, didk I Agree to continue. You must accept the
agreement to install indigo-scada-binaries-07-08-2014-10-52-rev 254,

rullsoft Install System w2, 46

I Agree I Cancel



file:///IndigoSCADA

# indigo-scada-binaries-07-08-2014-10-52-rev256 Setup o [ 5
Installation Complete (

Setup was completed successfully.

3

Completed

|
Show details |

rullsoft Install System w2, 46

Zancel |

After few seconds the installer will copy the required files and IndigoSCADA will be
ready to be used.

Uninstall of IndigoSCADA

To remove IndigoSCADA from your PC, simply delete the destination folder
C:\scada used during the installation process.

Firewall exceptions
Create the following exceptions on the firewall:

dspserver, rtsqlserver, sqlserver, rtps mngr

Installation 9
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IndigoSCADA project management

After the program is installed, all the project files are located in the folder
C:\scada\project Project files have the following file extensions: .dbs .fdb .ui .db .ini

These file contains empty databases, except modbus_databasel.db which contains
a predefined modbus configuration with 24 points.

You may zip the C:\scada\project folder to do backup and restore of a project.

The empty databases of the IndigoSCADA distribution are contained in the
empty_project.zip backup file.

Every time you want to create a new project, you need to create an empty directory,
then unzip the files contained in empty_project.zip file into the empty directory. Set
the path of the new directory in file C:\scada\bin\project.ini, restart manager.exe,
and continue with the configuration of the empty project. Otherwise you can press
the button Set project folder and select a folder where there is a project.

Starting IndigoSCADA

After the program is installed, it is possible to configure the empty project and start it
to runtime.

FEX
File  Modifica Visualizza  Preferiti - Strumenti 2 -4’
e Indigtra = J lw )__j Cerca = Cartelle v
Indirizze |5 Ci\scadalbin v| B vai

e

Im;ostazioni di configurazione
1KE

e
6.9.3.113
Windows Image Helper

dbase.dl

Operazioni file e cartella

J Crea nuova cartella
@ Pubblica cartella sul Web
s Condividi cartella

dnp3master dnp3slave dspserver

rmm
1[1%

histaricdb H H

Impastazioni di configurazions hrri_designer
1KE

fifa.dll

Altre risorse

I5) scada

@ Dracurmenti

153 Documnenti condivisi

iec61850client iecE1850server

manager
Impostazioni di configurazione
ZKEB

'vj Risorse del computer
W Risorse direte

lightopc.dll manager

manager
Documnento di kesko
1 KB

modbus_databasel
File del database
Z kB

B modbus_master
Dettagli

modbus_table
File 5%
]

monitar opc_client_ae

EEN

RE2AR|N

Open the subdirectory C:\scada\bin and double-click on manager.exe.

The main applet Manager shows up. This applet can be used to conveniently start
and stop IndigoSCADA without worrying of opening or closing all the sub-processes
it opens during the operation.
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=101 ]
—Control board
Start IndigoSCADA
Stop Indigo SCADA
Set project folder
Project folder:
C:*scada‘project

At the beginning there is only one Administrator User which can be used to access

the program. After the first login, it will be possible to add new users and configure
user permissions in detail.

Use Developer as Name and qwerty as password.

Name Developer

Password ek

Ok Cancel

Insert a new password to change the default one or press then Cancel button to skip
this phase.
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Quick tutorial with IndigoSCADA

In this tutorial we will use a Modbus Simulator called PeakHMI, which can be
freely downloaded from http://www.hmisys.com and use it to subscribe a few data
which will be used to animate some graphics object in one of the main tabs.

Setting PeakHMI simulator

Start MODBUS TCP slave and next, set up the communication preferences by click
on File->Settings menu

(T PeakHMI MB TCP Slay - 10| x|

File ‘Windows Help

Clients Connected: 1
Receiving 752

Settings.. x|
0] 4
Part Mumber: |5E|2

Delay Time:  [200 (0 - 10000 miliseconds)

Cancel

Qur Slave ID: |1

Float Byke Order

¥ Load registers ak skart

and setting 502 as Port and Our Slave ID = 1.

Then let's create a virtual device defined by IndigoSCADA as a Unit. Select
Configure Units from the menu Configure, press the button New and add a new
Unit. Name it MDB (=MODBUS) for example and enable it by setting the relative
checkbox.

12



Unit Configuration

{* Test Modbus Unit [

modbus_driver

Choose modbus_driver as Type and press the Configure button to set some specific
options. Select TCP as Context, 127.0.0.1 as IP address, 502 as Port, 24 is the
number of total sampling points (N items) belonging to this unit and 1000 ms as Poll
interval.

= Modbus_driver Configuration

-

tn
o

-

woB
[127001
[so2
I
o 3
o 3
o =
[ =

.- |

[1000 — 3]

:
W
|

Quick tutorial with IndigoSCADA 13



If you want to use a serial slave simulator: start MODBUS RTU serial slave
simulator:

(7 PeakHMI MB Serial 5l = 0] x|

File ‘Windows Help

Request: 7079
Responses: 7079

and next, set up the communication preferences by click on File->Settings menu and
configure the slave parameters 9600, 8, N, 1, Our Slave ID 1:

settings.. x|

(8]4

Delay Time: 200 (0 - 10000 miliseconds)

i |
Cur Slave I0: Il ﬂ

Float Biyte Order  |BE 3,4,1,2 |

[+ Load reqisters at start:

COM Pork: |4 vI [Data Bits: IB vI
Baud Rate: IQE.DD vI Stop Bits: |1 vI
Parity: INDne "I RTS: IDisaI:uIe "I

In IndigoSCADA select RTU as Context, COM3 as Serial device, 9600 as Baud, 8 as
Data bits, 1 as stop bit, N as parity (N= None, E= Even, O= Odd parity), 24 is the
number of total sampling points (N items) belonging to this unit and 1000 ms as Poll
interval.

14



£’ Modbus_driver Configuration

-

[+]
wosz
r
r
fcoms —

g

:
W
|

Press Apply button and wait it return active, than press Exit button.

Unit Configuration

{* Test Madbus Unit [)

modbus_driver

Quick tutorial with IndigoSCADA
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Choose Restart Monitor from the System Control menu. Confirm the Restart
operation by pressing the Yes button.

&£ Restart Monitoring

\il) Restart Monitoring Are You Sure?

Yes |

In the Modbus console you will see that the client is requesting data and

ODBUS RTU device COM3 BAUD 9600 DATA BITS 8 STOP BI

<A1 ><81 ><P1 ><AA><{51><88 >
modbus_read_bits: value = 8
[B11[6811[6A1[A7]1I[AA]1[61 1[4C1IBE]
Waiting for a confirmation...

<81 ><81 ><{P1 ><AfA><{51 ><88 >
modbus_read_bits: value = 8
[B11[83]1[6A1[BA1IAE][G2 1LE4]106871
Waiting for a confirmation...

<081 ><{A3 >{B4><AA>{BA><{AB8 > BA><FA><33>
modbus_read_registers: Get integer: @
[B11[A3]1[6A1[ZA1IAB][G2 1LCS51L0C1]
Waiting for a confirmation...

<@1 ><{83 >{B4><B8>B0><A8 > B ><FA><{33>
modbus_read_regiztersz: Get float: B.0600000
[B11[A31[6A1[411[8B1[61 1[D41[1E]
Waiting for a confirmation...

<A1 ><{A3 ><{B2 ><FF>{FF><{B? »{F4>
modbusz_read_regizters: Get integer: —1
[A11[A21[6A1[211[A@1[6A1 1[E?1LCA]
Waiting for a confirmation...

<81 ><82><{P1 ><A8>{A1><88 >
modbus_read_input_bits: value = B
[B11[831[6A1[41 1861061 1[D41[1E]
Waiting for a confirmation...

that new Status tab is now populated with 24 green rectangles, each one showing
the value of one specific Modbus data from MDBPoint0O1 to MDBPoint24.

16



=% IndigoSCADA Client

DEEESSO Y

[== (= m]

VALUE (™)

Reading and writing Modbus parameters

In IndigoSCADA Status tab, green is associated with OK status, light blue with not
acknowledged alarm states and red with acknowledged alarm states.

If we interrupt the Modbus communication in PeakHMI, then all the rectangles will
become blue because data values are now invalid.

Quick tutorial with IndigoSCADA 17




= IndigoSCADA Client

File Reports Configure Systern Control Help

T ET SIEW- = [

Alarms |Status Messages | hmil.ui | hmil.ui | hmi2.ui | hmi3.ui | hmid.ui | hmis5. ui | hmi&.ui | hmi? _ui | hmiS.ui | hmig_ui |

MOBFoint03
0.00 sp

MOBPaint10 MOBPOINt1 1 MOBFaint12
0.00 sp 0.00 sp 0.00 sp

We used 24 items of data in the Unit options MDB because IndigoSCADA comes
already with a predefined set of 24 Modbus points, (named MDBPoint01,
MDBPoint02, etc.) for quickly test it with PeakHMI.

Select Configure Protocol from the Configure menu and then open the file
C:\scada\project\modbus_databasel.db. Select the Browse Data tab and look to
the predefined definitions of the 24 points.

18



= IndigoSCADA Protocol Configurator - C:fscada/ project/modbus_databasel.db = II:IliI

IO e | E e o | E 6

Database Structure | Browse Data IEmecute SaL I

Table: Imodbus_table LI @_\l Mew Record I Delete Record I

!

-
(=]
(RN X ) Y [Py [ R [ [P [P [P Y [P Y

modbus_function_read | modbus_function_write | modbus_address | modbus_type | ioa_control_center | deadband = |
WT_BOOL
WT_BOOL
VWT_BOOL
WT_BOOL
VWT_BOOL
VWT_BOOL
VWT_BOOL
VWT_BOOL
WT_I4

VT_R4

WT_l2

WT_BOOL
WT_BOOL
WT_BOOL
WT_BOOL 15 LI

A o

’ | 1-240f 24 . | Go to: ||D—

(== IES I S L
G| =l [ || b |t P

o

i m
[=RE=RE A A A T N =]
2]

iy
=]

—_
—_
—_
m
m
tn
—
o

-
P
[=]
[}
7]
-
)

-
W
=]
4
X

iy
i

Ao pwfww|aa oo a oo
-
=]
-

_

.

-
tn

[ ]
M| =

The first five columns refers to typical Modbus parameters. For every point, it is
defined the Slave id, Read function, the Write Function, Address and so on.

The other column is specific for the IEC 870-5-104 protocol because every signal is
treated internally by IndigoSCADA as an IEC 870-5-104 protocol data.

The first record, ioa_control center 1 is a Boolean data with modbus address O,
modbus function 1 is used so this point is a modbus coil output.

The column modbus_address is an offset relative to the first address of the function
used.

Record 1 has modbus address 0, coils function 1 is used, so add the first coils address
(000001) and you get actual modbus address 000001;

Record 11, has modbus _address 65, holding registers function 3 is used, so add the first
holding registers address (400001) and you get actual modbus address 400066;

Record 12, has modbus address 33, discrete inputs function 2 is used, so add the first
discrete inputs address (100001) and you get actual modbus address 100034;

Activate alarming for MDBPoint01 with the following procedure:
MDBPont01 is a single point (M_SP TB 1)

Quick tutorial with IndigopSCADA 19




Point Number 01

Point Number 02
MDBPoint03 Point Mumber 03
MDBPoint04 Point Mumber 04
MDBPoint05 Point Mumber 05
MDBPoint06 Point Mumber 06
MDBPoint07 Point Mumber 07
MDBPoint08 Point Mumber 08
MDBPoint09 Point Mumber 09
MDBPoint10 Point Mumber 10
MDBPoint11 Point Mumber 11
MDBPoint12 Point Mumber 12
MDBPoint13 Point Mumber 13
MDBPoint14 Point Mumber 14
MDBPoint15 Point Mumber 15
MDBPoint16 Point Mumber 16
MDBPoint17 Point Mumber 17
MDBPoint18 Point Mumber 18
MDBPoint19 Point Mumber 19
MDBPoint20 Point Mumber 20
MDBPoint21 Point Mumber 21
MDBPoint22 Point Mumber 22
MDBPoint23 Point Mumber 23
MDBPoint24 Point Mumber 24

Point Number 01

press “Limits...” button and set the value of the single point (0 or 1) to associate with
the alarm state. In the next picture the value of 1 gives an alarm state.

Digital Alarm Configuration Receipe[(default)]

WVALUE

Restart monitor:

20



x|
@ Restart Monitoring Are You Sure?

‘res | _, ............. ',h .............

Return to the Status tab, right-click on the first green rectangle and choose Send
Command.

e e | ——
Alarms BSSages |IhmiEl.Iui |hmi1.ui |hmi2.ui |

Q:! Inspect (Last 2 hours], .,
O:] Inspect (Last day)...

O:! Inspect (Last 2 daws)...
O:! Inspect historical data...

Send command. .

Write 1 in the Value text box and press OK button. The rectangle will become light
blue and in the right part of the window a new Alarm will be notified.

Quick tutorial with IndigoSCADA
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=7 IndigoSCADA Client =151
File Reports Configure System Control Help

Mﬂmﬂlum_ﬂﬂ-]

Messages | hmi0.ui | hmitui | hmi2ui | hmizui | hmidui | hmisui | hmigui | hmi7ui | hmigui | hmigui |

MDBPoint01

Point Number 01

4] | 2l
Name | Lower Alamm [ Lower Warming | Upper w:
VALUE () ) )

Return back to PeakHMI and you will see that the data value of coils with offset zero
(mapped with MDBPoint01) is now 1.

_ioix
Cails Holding Registers Inputs Input Registers
: ! Qned nsigned (=
oo o0 o0 0o /0/00 Q0 000 0 0 0 1 1 —
oo o0 00000 000 0 0 0 00 0
oo o0 00000 000 0 0 0 00 0
oo/ o0 000 00 0 00 000 00 u]
oo o0 00000 000 0 0 0 00 0
oo o0 00000 000 0 0 0 00 0
oo 0 0 Q0000 0 00 00 Q0 00 0

The same operation can be executed with MDBPoint11, which is an integer type.
Send a command of 1000 for example,

22



Modbus_ driver Command

Mame | MDEPaint1 1

walue | 1000

Ok |

Help |

Cancel |

and then return to the PeakHMI and select the Holding Registers.

@-Data Monitor ;Iglgl
Coils Holding Reqisters Inputs Input Reqisters
# Signed |Un5igned Float |1E.| 15| 14| 13| 12| 11| 1u|9 |3 |?ﬂ
400050 1] o 0aoaoooo o oo o000 o o0 0 C
400051 0 o 0 o oo o000 o o0 o0 cC
400052 1] o 0aoaoooo o oo o000 o o0 o0 cC
400053 1] 0 0 o o000 0 0 o0 cC
400054 1] ] Qaooaoo0 o o o0 o0 o0 o0 0 o0 o c
400055 ] ] 0 o o o0 o0 o0 o0 0 o0 o c
400056 1] o 0aoaoooo o oo o000 o o0 o0 cC
400057 0 o 0 o oo o000 o o0 o0 cC
400058 1] o 0aoaoooo o oo o000 o o0 o0 cC
400059 0 o 0 o oo o000 o o0 o0 cC
400060 1] u] 0ooaoaog o o000 0 0 o o0 cC
400061 ] ] 0 o o0 o0 o0 o0 o0 0 o0 o c
400062 1] ] Qaooaoo0 o o o0 o0 o0 o0 0 o0 o c
400063 0 o 0 o oo o000 o o0 o0 cC
400064 1] o 0aoaoooo o oo o000 o o0 o0 cC
400065 1] o 1,401295464.532452E-42 o oo o000 o o0 o0 cC
400066 1000 1000 ES030000 oo /o 1t /o1 1 1 11
400067 1] 0 0 o o000 0 0 o0 cC
400063 1] ] Qaooaoo0 o o o0 o0 o0 o0 0 o0 o c
400069 ] ] 0 o o o0 o0 o0 o0 0 o0 o c
400070 1] o 0aoaoooo o oo o000 o o0 o0 cC
400071 0 o 0 o oo o000 o o0 o0 cC
400072 1] o 0aoaoooo o oo o000 o o0 o0 cC
400073 0 o 0 oo/ 00 00 0 0 0 C,
| Ry

The value of the 400066 register will

be 1000.

In PeakHMI select Inputs and change the value 100034 to get a change in the value

of MDBPoint12

Quick tutorial with IndigopSCADA
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f_r?g-[)ata Monitor

Coils

#

Halding Reqisters Inputs Input Reqisters

1 |2 |3 |4 |5 |5 |7 |3 |9 |1l]|11|12|13|14|15|15|5igned

Unsigned

=10l x|

100001

100017

100033

100049

100065

100081

100097

100113

100129

100145

100161

100177

100193

100209

100225

100241

100257

100273

100289

100305

100321

100337

100353

100369

100385

oo /o0 Q0 00 Q00 o0 0 00 00

1]
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1]

[ Y e Y e I e I e e I e I e S e O s s s s s s e O e O T T e e T T A T e |

I

Animate graphics objects with process data

Binding a graphic object with a process data is very easy. Let's begin with a Boolean
type (True/False) to animate three object: a rectangular led, a counter and circular

led.
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Open the HMI Designer by choosing Configure HMI from the Configure menu,
select the OpenFile/Project Tab and open one of the .ui files present in
C:\scada\project (hmil.ui for example)

Fopen x|
‘UC) | . = System (C:) - scada - project - - @J ICEl'ca [g]
Organizza * &3 Visualizza + | | Muova cartela (7]
Collegame Mome = |v| Data acquisizione |v| Tag |v| Dimensione |v| Classificazione |v|
o
B D i, i hru|1 IJI hmi 2, i hmi 3, i i, i by 5, i i, i
- c..
B . . .
& m.. |
& M.
D g himi 7. Ui hmid. ui himig. Ui
F...
Cartelle
Mome file: |hmil.ui j IDesigner Files (*.ui ~ pro) j

poi || Annla |

&

or create a new dialog:
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New File/Project |[_:penﬁ|en=mjed | Recently Opened |

C++ Project

& i

Wizard

Main Window

Widget

[T Don't show this dialog in the future

Help

oK

Cancel

4

Press OK button and save Form1 with .ui file extension in C:\scada\project

¢ IndigoSCADA HMI designer

File Edit Project Search Tools Layout Preview Window Help

1D S @lero =

j
[&|

[/ ROBQT [E][m = 8w E B[ wm|k =%V

Common Widgets

Buttons

Containers

Views
Database

Input

Display

SCADA Widgets
£+ Dial

L, Plat

é—% AnalogClock
PushButton
a Scale

O SinglePoint Led
m PTarnk

) PDoublePointLed
B rome

@ rieter

‘f'.j__‘ Knob

. Courter

j m ICerca

6@ I . C:\scada'project

Nome file: Ihn‘lil.ui

Salva come: IQt User-Interface Files (*.ui)

ig
(o[

Objects I Members

W Nkl Dird |~

2 Sfogliamrbellel Salva I Annulla |é]gi g:om1 ;];:lg
L ige
I e g
o
R  [o]
L g
e Properties | Sigral Handler:
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Then, “draw” these three objects from the SCADA Widgets toolbar onto the map:
e PLCDNumber
* SinglePointLed
* PsinglePointLed

SCADA Widgets

£ o IndigoSCADA [IndigoSCA|
L, Plot IndigoSCADA IndigoSCAI

%Zﬁj IndigoSCADA IndigoSCAI

E ol IndigoSCADA  IndigoSCAI

m FTank
) PDoublePointLed

Ei Thermo

. Phdeter

.= Knob

Counter

© DoublePointLed
[ wheed
e = Slider

E PLCOMumber

&3 PSwitch
] FToggle

"f,— Compaszs

&3 Breaker
E‘“ PThermorneter
(D) PSinglePointLed

Rename these objects with format UnitNamePointXX oldname (es.
pLCDNumber5 becomes MDBPoint01 pLCDNumber5 and so on) using the
Property Palette. Do this for all three objects.

||| Froperties |SignaIHandIers I

Property W alue =
name MOBPoint1_pLCOMHumbers
enabled True
geometry [30,7110.81, 31 ]
sizePalicy Minimurn A inimun /040 |
minimumS ize o.o]
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Ohjects bl embiers

M ame Clazz
=) —
03 testlabell [Label
Q pixmaplabel [Label
{> pixrnapl abell [Label

----C)MDBF'u:uintEI1_|:uSingIeF'u:uint... PSinglePointled
----OMDBF‘Dintm_singlePuintLe... SingleFaintLed

----MDEP‘DintEﬂ_pLEDNumb... PLCD M umber

Properties I Signal Handlers

=" IndigoSCADA Client
File Reports Configure System Control Help

= BB B fu

Alarms | otatus | hessages | himill. ui

==
o
@

Save the map and exit IndigoSCADA Client by choosing Exit from the File menu,
After few seconds, the client will be opened again and in the hmil.ui tab those three
new objects will be inside.

Now open the PeakHMI Data monitor window, select the Windows->Register data
menu and change values of the coils

7 IndigoSCADA Client
File Reports Configure Systern Control Help

=10 IS 5 : |

Alarms | Status | Messages | hmid. ui | Ih

- @

The graphic object will begin to flash because Point is in alarm state.
Press the Acknowledge All Alarms button to stop the animation.
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= IndigoSCADA Client

File Heports Caonfigure Systemn Control Help

=5 B Bv fu

At the moment there is no contextual menu associated with these object: pressing the
right button on it won't do nothing. So, now we will enable it. Open again the map
hmil.ui with the HMI Designer, right-click on the pSinglePointLEd and choose
Connections

............ | ..
|- om - m ‘ Cut Chrlx
: L i m X -
....................... Copy CErl+C .
Z:::Z:::Z:::Z:::Z:::ZZZE_L;F'aStE ChH Y
P Delete el
Cooooc o SmDigl7 e [l Adjust Siee Ctrk+3
N (MM} Lay Gut Harizantall Zhrl+H
an ==
mi. .. ... = Lay dut Yerkically ZErH-L
aff [ . .
Coo % Law ut in a Grid (Zhr|H-G
e . J4+J Lay Qut Horizontally: (in Splitter)
..... SimAdels
I : Z Lay Out Werkically (im Splitbery |
10.00_ y Z% Break Layauk ZErl+B
g oo
i SouUrce, ., krl+E
oo 000 :

Add a new row as shown in the picture below.
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= ¥iew and Edit Connections

Caonnections:
Sender | Signal | Receiver | Sliot |

" 1 |Simadc05_pThermometer] RightClicked[C String®, Q1 Stringd) Formnl RightClicked[CStingd: QS tringd]
w” 2 |Simtde0l_pTankl RightClicked[Q5tring 0 Stringd) Farm1 RightClicked[Q String®, 0 Stringd)
w” 3 | Simtde02_wtT hermal RightClick.ed[CString®: QS tringd) Forrnl RightClick ed[QStingd. 0 Stringd]
w4 |SimDig03_pDoublePointLed] RightClick.ed[Q String®:, QS tringk) Farrnl RightClicked[QStingd, 3 Stingd)
%" 5 | SimDigl4_pSinglePaointLed! RightClicked{QString 0 Stringd) Farmni RightClicked(Q String®, 0 Stringd)
w” B | SimDigl7_pSwitchl RightClicked[Q5tring 0 Stringd) Farm1 RightClicked[Q String®, 0 Stringd)
w” 7 | Simtde02_pLCDMurnberd RightClicked[lStringd 0 Stringd:) Farm1 RightClicked[String®:, 0 Stringd)
w8 |SimDig04 pLCDMurmbers RightClick.ed[Q String®:, QS tringk) Farrnl RightClicked[QStingd, 3 Stingd)
%" 3 | 5imDigl3_pLCOMumberd RightClicked{QString 0 Stringd) Farmni RightClicked(Q String®, 0 Stringd)
10 SiraDigN7 ol Mk D BightClick edlif Shingh G Shingd] Furnl BlightClick e dif Shiegd S bringk]

"W A b MDBPointD1_pSinglePointLed Rig ed( ok at 0 Rig ed(( gk.0 gt

Save the map, close the IndigoSCADA Client, and now it should be possible to
interact with the object. Right-click on the object and send a command with a value of
Zero.

Inspect (Last 2 hours)...  |[—

In=pect (Last day)...

oy
C
O:\n Inspect (Last 2 days)...
oy
_|

SimDig07 Inspect historical data...

Send command. .

[l ‘

= IndigoSCADA Client
File Reports Configure System Control Help

eSO 2 el

Alarms |Status |Mesaages |hmiEI_|_|i | hmit . ui I

- @

==

Using the same procedure, it is possible to animate graphic objects connecting them
with analogue process data.
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Open the HMI Designer, and rename the three objects Pthermometer, Ptank and
thThermo using the formula UnitNamePointXX oldname.

................................................ SimaAdcl? o
I o= . x-S R .
1000.00_ . | 1000.00. 1000
747.50_ | soooo 800

49500 T o0 0.00 son: _:
24250 | sooon i
| 400 i
1000 __nan -1000.00 ]
DR 200 |
—— | ] = SEEEEE oI i
o PThermometer . .. ... . PTank . ..o th"l-'herma ..... L
Objects I bembers I
M ame Class ;I
_ H Sim&dc02_plLCOMunn...|PLEDMumnber
: --i FDBPoint11_wtThermol |EwtT hermo
[ testLabell (L abel
{b pixrmaplLabel? [ALabel
{b pixrmaplLabe [Label
----EMDBF'-::intD'I_pLEDNumI::... PLCDM urber
----QMDEF"DintD'I_pSingleF’Dint... FSinglePointLed
----DMDEPDintm ginglePointLe...| SinglePaintLed
1| m MOEPaint11_pT ank1 PTank
---i‘MDEPDinH1_;Thermnmet... PThermaometer =
Set type of MDBPointl1 to M ME TE 1, accordingly to modbus_databasel.db
column iec type read.
The PLCDNumber object require the setting of numDigits, 6 digits to display
correctly MDBPoint11 which is a 16 bits signed integer (VT 12).
lineWidth 1
mangin 0
midLineWidth 0
smallDecimal Py False
l§ E[ﬁg‘ts G §
mode Dec
SeomeniSiie — >
value 0
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Dinamic bitmaps

Use the Breaker widget to animate single point bitmaps. The bitmaps are selected in
Properties Onpixmap and Offpixmap.

Onpixmap is shown in HMI when the value of the point is 1.

Offpixmap is shown in HMI when the value of the point is 0.
=lox|

File Edit Project Search Tools Layout Preview Window Help

I IE Fa e I EE R 1A

<No Project

E
Common Widgets
Buttons <No Project> =
Containers : ect
Views
Database
Input
Display LI
SCADA Widgets |
3 Scale cl d
ass
SinglePointLed
© SingleFos . PLCDNumber
o PTark CQwtFl
int0... GwtPlot
© PhoublePointLed
:i ™ ... [Gwt Themo
| Themo
». o int2... GwtPlot
eter
o kech int2... PLCDNumber
(4 Knol =
Courter
X
© DoublePoirtLed =
m Properties I Signal Handlers
Wheel
Property Value ;I
e = Slider mouseTracking  |False
E PLCDMumber focusPolicy StrongFocus
. scceptDrops False
d P Switch switchValue Falze
§ FToggle OnLabel on
E =T ompass = o,
Oro
&3 Breaker i Q \
: L o o)
e o Themo, ;1 FEanlTp e
P ln dican v A T A lm dicum v A T A lom Adimicoms A A s || B whatsThis hd
Custom Widgets « r LI
|Ready
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Use DoubleBreaker widget to animate double points bitmaps. The bitmaps are
selected in Properties Onpixmap, Offpixmap, Invalidl1pixmap and InvalidOOpixmap.
Onpixmap is shown in HMI when the value of the point is 2.

Offpixmap is shown in HMI when the value of the point is 1.

Invalid11pixmap is shown in HMI when the value of the point is 3.

InvalidOOpixmap is shown in HMI when the value of the point is 0.

B IndigoSCADA HI i

File| B Form1 — — - )
[ il GHAKHAR A NGHAKHAR A MANGLAII N MANGLAT MW
@ H u u u
1 n n n
{ n4 na na na A ! 9
n n n n 3 !
E10 u —& u —& u —& u —& AME Propertes. | Signal Handiers |
amn & & L+ & Propery Value -
Ll D08 DO7 D06 DO5 name freakeri_3.3 o]
St sebled] T
0 He é é é é 0 geometry  [877.100,20,2..
Qn sizePolicy |Prefemed/Prefer..|
Gt é é é é minmunSize  [0,0] |
merdmmize | 767, 3206571 |
Q12 paleticForegro..
palstteBackar. [
! ! ! ! _paletieBackar.. |
Q31 RA EW palstte | —
é é IZ]ZI é e {badexonmedO Widor Cuor I
Qo3 fort S Shell Dig 8
a2 potnss - |
$ $ & $
K g g focusPolicy _ StrongFocus
acceptDrops _|False
ot swtcnse 0
e é é é OnLabel on
 OffLabel off
1 H 1 Offpbanap
882 : el pi... )
Q20 0 Hz n s n Q} n o o Invalid00pi... |
u = u 2 u 1 1oolTip
n - n - n
HH n H n H n MVAR whats This
u T ul H 2%
n n n e
u Tap u Tap u Tap
= =l

Ready
Py

4:04 PM ]
12-Jul-19

o [
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Historical data analysis

Cf Inspect (Lask 2 hours), .
Cf Inspect (Last day). ..

O:] Inspeck (Lask 2 daws). ..
Cf Inspeck historical data. ..

| Send command. ..

IndigoSCADA Client allows to inspect data in order to analyze the data and observe
the trend of the process data. Go to the Status tab and right-click inside one the
rectangles representing process data (e.g MDBPoint11) and choose Inspect last
two hours for example.

The ongoing trend of MDBPoint11 will be shown in a new window.

& MDBPoint11 [ Point Number 11] sp.
File

MDBPoint11]| Point Number 11 Name p Minimum [ Mazimum | Average | Std. Dev. [ Updated

Name | Lowar Alarm | Lower Waming | Uppar Waming [ Upper Alam
\ALUE -10000 ] ] 10000

20522.0 VALUE

236224

17716.8

112112

50056

i}

5905 6

112112

-17716.2

-23622.4

205220

133446 133559 1339:12
ar mog 28 2013 mormag 28 2013 mar mag 28 2013

Alarms and Alarms group

As seen above, IndigoSCADA Client uses color to show the process data status.
Sometimes, hovewer, it would be necessary to monitor many points at once and have
one calculated point which is the OR combination of all these point. This point could
summarize those point for example. This functionality is carried out by
IndigoSCADA client using the Alarm Group functionality.

Suppose you need a calculated point called A (=Plant Alarm) which must true on
whenever MDBPoint01 or MDBPoint02 are true.
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Choose Configure Alarms group from the Configure menu and create a new point

pressing the New button.

-‘5_ MNew Item

Marne A

Ok Help Cancel

Now we will have a new group Alarm named A.
Add MDBPoint01 and MDBPoint02 to the list for the alarm A.

Mame IA j

Comment I(”‘*’J

Sarmple Points Paints In Group

MDEP 0int03 MDBPoint01
.MDEIF'Dinthl Add == MDEPaint02
MDBEPaint05
MDEP aint06
MDEPaint07
MDEPoint08
MDEPaint09
MDEPaint10
MDEP oint11
MDEPaint12

<< Hemove

i

Apply | M. .. | Delete | Help Exit |

Apply these settings and close the window.

Change values in PeakHMI and look at the Alarms tab. In this example
MDBPoint01 has got value 1(light blue=alarm) and so the Plant Alarm A has
become an alarm too.

Quick tutorial with IndigopSCADA
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= IndigoSCADA Client

File Reports Configure Systermn Contral Help

DERESNO

B

Alarms IStatus | Messages | hmidui | hmitui | hmizui | hmigui | bmigoui | hmisi | gl | izl | i | hmis.y

Mame |Cnmmem |Update

A

Update

MDEPoint01

A,

= 2013-06-03 13:02:00.73

|MDEIF'DintEI1 2013-06-03 13:02:00.734

Right-click the MDBPoint01 and choose Acknowledge Alarm.

| hrnil ui | hrmi2.ui | hrni3.ui | hrnid ui | hrmi. ui | hrni6. ui | h

A,

Update

| [MODBFoint01

2M3-06-03 13:0 &

IMDBPointD1

O:] Inspect (Last 2 hours). ..

Cf Inspect (Last day)...

Cf Inspect (Last 2 days)...
O:] Inspect historical data. .

_| Send command. ..

Acknowledge Alarm...

Point Number 01

MDPoint01 changes his state in Acknowledged Alarm and Plant Alarm A changes

this state too.
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= IndigoSCADA Client

File Reports Configure System Contral Help

Dnapzson v aElE

Alarms IStatus | Messages | heiui | hmit o | bemi2ui | hmidui | beidui | heiso | bmBoui | heir o | bmisui | heig

Name | Comment |Update [ESI— o MDBPoint01 | Point Number 01

You can create as many alarm groups as you want.
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Menu of IndigoSCADA

File menu
Reports menu
Make

Review Print
Alarms Report
Events Report
Audit

Report Configure
The reports generated by the system are fairly simple.

Report Configuration

Comment/Title I(”*)
Time Frame Template
From ILast Hourj |00:00:00 |2013-05-02 Front () -
Tabhle [ |-
To INOW -] |00:00:00 |2013-05-02 GraphiStat: [~ =
Table Filter | All Resuls - Pack ) =

MODBPoint01 o

— Add =>
WMDBPoint02 4'
MDBPoint03

<< Remove

WMDBPoint04 4'
MDEBPoint05
MDEBPoint06 Ju

MDEPainta7
MDEPaint08

bACVE D om0

Apply | T | Delete | Iake | Help | Exit

-

The Name field selects the report to be examined or modified.
The Comment/Title field is the title or description of the report.

The From and To fields define the time frame of the report. There are three parts to
the From and To parts of the time frame, the type, a date and a time of day.

The type field can be for the From field:
e Last Hour
o Last Four Hours
o Last Twelve Hours
e Last Day (last 24 hours)
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o Last Week (last 7 days)

o Date-Time (an explicit date and time, right click on the date field to get a
calendar)

o Today (the date is current day and time of day is the given time)

e Yesterday (the date is previous day and time of day is the given time)
The type field for the To fields:

e Now. The current date and time.

o Date-Time (an explicit date and time, right click on the date field to get a
calendar)

o Today (the date is current day and time of day is the given time)
e Yesterday (the date is previous day and time of day is the given time)

The Add button copies from the available sample points list (left) to the reports
sample points list (right).

The Remove button copies selected sample points from the reports sample points to
the available sample points.

The buttons at the bottom have the following function:

Apply. Any changes are made permanent for the currently selected report point.
Unless Apply is pressed any changes are discarded.

New. This creates a new report. The New Report dialog is displayed and the existing
report listed. The new name must consist only of letters and numbers. The name
must be unique (ignoring case).

Delete. The selected report is deleted after a confirmation.
Make. The selected report is generated and displayed.
Help. This displays this help page.

Exit. The dialog is closed.

Batch Editor

Pen Trace
Pen Trace is used to draw process data trend and make analysis.
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Configure menu

System Configuration

System Mame IndigoSCADA

Comment IndigoSCADA tr{Client)

Default Language

Audit Level Log Without Comment j

™ Auto Log Out Time (minutes) |, =

[T Reset Statistics At Midnight

Ok Help | Cancel

Configure SystemThis dialog sets up system wide parameters.
The System Name is the name of the system. This is used in the application title bar.

The Comment is a long (free text) description of the installation.

Default Language sets the language to use when starting up. Users can select a
different language to use after logging in.

Audit Level sets the type of change auditing that is performed. The setting may be
None (for no auditing), Log Without Comment (changes are logged silently) and
Log With Comment (requires the user to enter a reason for the change).

Auto Log Out Time. When checked a user is logged out automatically after the
selected number of minutes.

Press the Ok button to accept and set the changes, then exit.

Press the Cancel button to discard any changes and exit.

Configure Users
This dialog allows users to be added, removed and configured.
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User Configuration

The Name field selects which user is being examined or edited.
The Comment field is a free text description of the user.
The Language field selects the language to use for this user after login.

The group of checkboxes select which privileges the user has. These control what
options are displayed to the user:

All Privileges. The user is a system administrator with all options and no
restrictions. Note that although the application will not prevent access or
modification of the system's configuration the privileges granted by the database
system (when starting the application) may not permit any changes to the databases.

Reports Design Privileged. The user can design reports.

Can Acknowledge Alarms. The user can acknowledge alarms.

Can Make and Print Reports. The user can generate, view and print reports.
The buttons have the following function:

Apply. Any changes are made permanent for the currently selected user. Unless
Apply is pressed any changes are discarded.
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New. This creates a new user. The New User dialog is displayed and the existing
users listed. The new user name must consist only of letters and numbers. The name
must be unique (ignoring case).

Delete. The selected user is deleted after confirmation.
Help. This displays this help page.
Exit. The dialog is closed.

Configure Units
A Unit is a piece of measuring equipment.

Each unit has one type of communication protocol associated with it.

This dialog provides the configuration common to all units. The configuration specific
to a unit type is selected by pressing the Configure button on this dialog.

Unit Configuration

Name MDE j

Comment [T

Type modbus_ driver -
I* Linit Enabled Configure. ..
Apply W= Delete. . Help Exit

The Name field selects which unit is being examined and modified.
The Comment field is a free text description of the unit.

The Type field shows what sort of unit it is. The type determines the driver protocol
used to interface to the equipment and to provide the configuration services.

If Unit Enabled is checked then the unit is by default enabled. Otherwise it is not
enabled, by default. This can be overridden when a recipe is loaded.

The Configure button opens the specific configuration dialog for the selected unit of
the selected type.

The buttons at the bottom have the following function:

Apply. Any changes are made permanent for the currently selected unit. Unless
Apply is pressed any changes are discarded.
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New. This creates a new unit. The New Unit dialog is displayed and the existing units
listed. The new unit name must consist only of letters and numbers. The name must
be unique (ignoring case).

Delete. The selected unit is deleted after confirmation. All associated sample points
are deleted if requested. The results associated with these sample points is not
deleted.

Help. This displays this help page.
Exit. The dialog is closed.

Configure Sample Points

This dialog configures sample points. Each sample point represents an input into the
system that measures one or more physical values. Each of these physical values is
named with a tag name.

The list on the left hand side shows the configured sample points and their
comments.

The Comment field allows a free text description of the sample point to be entered.

The Unit field selects the unit associated with the sample point. All sample points
must be connected to a unit.

The Type field selects the type of input. This in turn (with the Unit field) selects the
specific configuration for the sample point.

The Input Index field selects the actual input of a given type into the given unit that
maps on to this sample point. The choices are determined by the Type and Unit fields.

The Units field sets the physical units for the sample point.
Pressing the Limits button opens the alarm threshold configuration dialog.

Pressing the Actions dialog opens the event action dialog. This allows certain
commands to be performed when a sample point is measured and/or a sample point
goes into alarm. This is an advanced user's function and although providing a
considerable degree of flexibility it can cause serious damage if it is incorrectly used.
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Sample Point Configuration

Comment | = [mDBPainto1
] i Point Number 01
MDBPoint02 Point Mumber 02
MDBPoint03 Point Mumber 03
MDBPoint04 Point Mumber 04
MDBPoint05 Point Number 05 Unit |MDE| j
MDBPoint06 Point Mumber 06
MDBPoint07 Point Mumber 07
MDBPoint08 Point Mumber 08
MDBPoint09 Point Mumber 09
MDBPoint10 Point Number 10 Input Index |01 j Limits... |
MDBPoint11 Point Mumber 11
MDBPoint12 Point Mumber 12

Units Ispi j Actions._. |
MDBPoint13 Point Mumber 13

MDBPoint14 Point Mumber 14

Comment I Point Number 01

Type | M_SP_TB_1 j

MDBPaint15 Point Mumber 15 ¥ Enabled ¥ Fileable Alarm Threshold
MDBPoint16 Point Mumber 16
MDBPoint17 Point Number 17 [ Use Log Graph Scales ™ Retriggerable Alarms ] -

MDBPoint18 Point Mumber 18
MDBPoint19 Point Mumber 19
MDBPoint20 Paint Mumber 20 I0A
MDBPoint21 Point Mumber 21

MDBPoint22 Point Number 22 |1
MDBPoint23 Point Mumber 23

MDBPoint24 Point Mumber 24 LI

Apply MNew... Delete | Rename | Help | Exit

The Enabled checkbox indicates if the sample point is enabled by default. This can
be overridden by loading a recipe.

The Fileable checkbox indicates if the data from the sample point is to be filed.
Normally this should be checked, however there is the possibility that some data does
not need filing (e.g. free disk space).

The Use Log Graph Scales check box indicates if the graphs for this sample point
should use logarithmic scales. This is normally set for particle counts type
measurements.

The Retriggerable Alarms checkbox indicates if a new alarm is registered for each
measurement in alarm. If not checked then an alarm is only generated when the
sample point enters alarm.

The Alarm Threshold field sets the number of consecutive alarms to be detected
before the alarm is logged. While waiting for the alarm threshold to be breached the
sample point is in a warning state.

The panel below the checkboxes is for the specific configuration fields. These are
specific to a particular unit/type combination and allow for additional configuration
(for example conversion factors).

The buttons at the bottom have the following function:

Apply. Any changes are made permanent for the currently selected sample point.
Unless Apply is pressed any changes are discarded.

New. This creates a new sample point. The New Sample Point dialog is displayed and
the existing sample points listed. The new name must consist only of letters and
numbers. The name must be unique (ignoring case).
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Delete. The selected sample point is deleted after a confirmation.
Help. This displays this help page.
Exit. The dialog is closed.

Configure Scheduled Events

Comment I (***)

Frequency I Every Monday j IOU:UO:UU
Trigger Point I ™) j I ™ j I » j IU
Report I =) j [ Print Report Edit Report... |

Receipe | () j Edit Receipe. . |
Action I
Apply | New... | Delete Help Exit

The Name field selects which event is being examined or edited.
The Comment field is a free text description of the event.

The Frequency fields set how often the event is run and the time of day or period
between events.

The Trigger Point parameters allow an event only to run when the given sample
point-tag value meets a given criterion.

The Report Field selects which report to generate (or (***) selects no report).
If the Print Report checkbox is checked then the report is printed after generation.
Clicking the Edit Report button opens the report design dialog.

The Recipe selects the recipe to load when the event is run (or (***) selects no
recipe).

Clicking the Edit Recipe button opens the recipe design dialog.

The Action field may be set to an action to be performed. If the action starts with a !
then the command is assumed to be a shell command, otherwise it is an SQL
command performed on the current values database. This is an advanced user

command, being very powerful it can cause considerable damage to a system. For
this reason the application must never run with root privileges.

The buttons at the bottom have the following function:

Apply. Any changes are made permanent for the currently selected event. Unless
Apply is pressed any changes are discarded.
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New. This creates a new event. The New Event dialog is displayed and the existing
events listed. The new name must consist only of letters and numbers. The name
must be unique (ignoring case).

Delete. The selected event is deleted after confirmation.
Help. This displays this help page.
Exit. The dialog is closed.

Configure Alarm Groups

Alarm groups allow the alarm state of a collection of sample points to be collected
together and handled as a single entity. The state of a group is the highest alarm
state of any of the alarm group's members. Alarms can be acknowledged as a group

Alarm Group Configuration

Comment I(*”*}

Sample Points Points In Group

MDBPoint01 =
MDBFoint02 Add >
MDBPoint03
MDBFoint(4
MDBPoint04
MDBPoint06
MDBPoint07
MDBPoint08
MDBFoint09
MDBPoint10
MDBFoint11
MDBPoint12
MDBPoint13
MDBPoint14
MDBPoint15

— <= Remove

Apply Mew._. Delete Help Exit

The Name field selects the alarm group to be examined or modified.

The Comment field has a free text description of the alarm group.

The Sample Points list is the list of sample points not in the alarm group.
The Points In Group list has the list of sample points in the group.

Clicking the Add button copies the selected sample points from the Sample Points
list to the Points In Group list.
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Clicking the Remove button removes the selected sample points in the Points In
Group list to the Sample Points list.

The buttons at the bottom have the following function:

Apply. Any changes are made permanent for the currently selected alarm group.
Unless Apply is pressed any changes are discarded.

New. This creates a new alarm group. The New Group dialog is displayed and the
existing alarm groups listed. The new name must consist only of letters and numbers.
The name must be unique (ignoring case).

Delete. The selected alarm group is deleted after a confirmation.
Help. This displays this help page.
Exit. The dialog is closed.

System control menu

Restart Monitor

This menu entry is used to restart monitor and make IndigoSCADA client aware of
new Units(= protocol devices) added using the Configure Units functionality

=’ Restart Monitoring x|

\i,) Restart Monitoring Are You Sure?

YES | _, ............. NU .............

present in the Configure menu.

Press Yes button to confirm the restarting.

Realtime database Management

Realtime database management is a sub-program used to inspect all realtime data of
IndigoSCADA. Using a SQL language it is possible to query data and administrate
the internal database.
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£ Real time database management _|a] x|

File Options Help

Ju 4 » n‘
Orline real time databases /| = NAME  [COMMENT [uni [arvee [unis [EneBLED [FILEABLE [IPINDEX [LOGMODE [ALARMTHRESHOLD |
& configdb MDBPoint01 | Point Number 01 [MDB  |M_SP_TA_1 [sp 1 1 01 0 [1]
EACTIONS MDEPoint0Z | Point Number 02 \MDB  |M_SP_TA_1 |sp 1 1 02, 0 a
B ALARMGROUP MDBPoiInt02 | Point Number 03 |MDB |M_SP_TA_1 |sp 1 1 03 0 0
EPBATCH MDBPoint04 | Point Number 04 |MDE  [M_SP_TA_1 |sp 1 1 04 0 a
EPPROPS MDEPoint05 | Point Number 05 \MDB  |M_SP_TA_1 |sp 1 1 03 0 1)
EFRECEIFE MDBPoInt0& | Point Number 06 |MDE  |M_SP_TA_1 |sp 1 1 08 0 1]
MDBPoint07 | Point Number 07 |MDE  [M_SP_TA_1 |sp 1 1 07 0 a
BReroRlS MDEPoIn08 | Point Number 08 [MDE |M_SP_TA_1 |sp 1 1 08 0 0
= MDEPoint08 | Point Number 09 \MDB  |M_SP_TA_1 |sp 1 1 03 0 0
EFSCHEDULE MOBFPoint10 | Point Number 10 MDB  |M_SP_TA_1 |sp 1 1 10 0 0
EPSERIAL MDEFoint11 | Point Number 11 |MDE  |M_SP_TA_1 |sp 1 1 i 0 a
EFTAGS MDEPoint12 | Point Number 12 MDB  |M_SP_TA_1 [sp 1 1 12 0 1)
EPUNITS
BPUSERS
& currentdb
BrALM_GRP
EPALM_GRP_STATE
EPCVAL_DB
EPPROPS
PTAGS DB
@ resuitsdb
B ALARMS
EFAUDIT
EPEVENTS
EPWVDBPoint01
EMDBPoint0Z2
EPMDBPaint03
-EFMDBPoint04
EPMDBPoint0s
EPNVDBPoint0s
EMDBPoint07 -
JT S _>|_I < o
Query: [select * from PROPS limit 150;] MNumber of records fetched: 20 Result ok
Query: [select ™ from TAGS limit 150;] Number of records fetched: 12 Result ok
Query: [select * from SERIAL limit 150;] MNumber of records fetched: 13 Result ok
[ APLE limit 150;] Number of records fetched: 12 Result ok

Execution of a SQL command.
Right clicking with the mouse on the configdb database icon, the popup window
shows up:

_—i Real time database management

File Options Help
' « » m

Online real time databas.+. ‘I NAME i

Furge Database

Cancel
[

=
=3
=
(%]
) I R I R |

Insert a SELECT query similar as shown below

_—_% Enter SQL Command for configdb ed |

Command for configdb

Iselect * from TAGS where 10A = 11}

(8] Cancel

The result shows how is recorded the MDBPoint11 sample point in the real time
configuration database (configdb) TAGS table:
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;% Real time database management - |:||5|

File Options Help
Ju « v u

Online real time databas=. naME | TaG | upPERaLARM] UP] L{ LowERALARM | uaEl un|Lw LaEn RecEPE [EnaBLED [i0A [PaRAMS [uniT
|1 [MDBPoin: 11/ VALUE 2000, 0|0 2000 1 0 0| 1 (defauh) T DB

B ACTIONS
- EF ALARMGROUP
--EF BATCH
B PROPS
-EF RECEIPE
--EF REPORTS
- SAMPLE
¥ SCHEDULE
[ SERIAL
~-EFTAGS
B UNITS
.- USERS
| @ currentdb
-EFALM_GRP |
EFALM_GRP_STATE
-BFCVAL DB
--EF PROPS
EFTAGS DB
| & resultsdb
B ALARMS
- AUDIT
EFEVENTS

. _>|j < | i

Query: [select * from TAGS limit 150;] Mumber of records fetched: 12 Result ok
Query: [select * from TAGS where IOA = 11:] Number of records fetched: 1 Result ok
select * from TAGS where I0A = 11;] Number of records fetched: 1 Result ok

File | Options Help

| W (%) View Date/Time
[

Cnli F  Maximum records...

& c &1 Set credentials. ..
ﬁ‘l’ﬂuuumuu
§F resultsdb

Select the Options Set credentials menu, it opens the following dialog where you
can set the user and password for accessing the real time database:

Menu of IndigoSCADA
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Cancel |

The Backup SQL function works in this revision. The restore function is

Note done with the SubSQL program.

Historical database Management

il
File Options Help
w « » H |
| online historical databases / TIMEDATE | STATE | VALUE | =
Iﬁ"‘resu\lsdb 1 1366895500461 1 2570
B ALARMS Z 1366895502473 1 2570
EFAUDIT |3 | 1366895503503 1 5140
-EFEVENTS |4 | 1366895504517 1 5140
- B MDBPoint01 |5 | 1366895506545 1 7710
- EF MDBPoint02 6 | 1366895508573 1) 10280
- E§ MDBPoint03 T_ 1366895511615 1 12850
- E§ MDBPoint 04 8_ 1366895513643 1 15420
B MDBPoint05 z 1366895516685 1 17990
--EF MDBPoint06 |10 | 1366895518713 1] 20560
--EF MDBPoint07 |11 | 1366895521755 1 23130
- EF MDBPoint08 |12 | 1366895524781 1) 25700
- EF MDBPoint09 13 | 1366895526825 1) 28270
- E§ MDBPoint 10 T 1366895529867 1 30840
=" MDBPoint11 ? 1366895531895 1| -32126
EfMODBPoint12 ? 1366895533907 1| -29556
E 1366895536965 1) -26986
|18 | 1366896964895 1 -24416
|19 | 1366896967922 1) -21846
20 | 1366896969965 1| -19276
F 1366896972992 1| -16706
Z 1366896975067 1| -14136
123 | 1366896978077 1) -11566
| | ] |24 | 1366896980137 1 -8996 [~
Query: [select * from MDBPoint11 limit 150;] Number of records fetched: 150 Result ok

A
Historical database management is used to analyze all the process data samples from
the beginning. It gives a low level access to all internal tables of IndigoSCADA

The MDBPoint11 table is selected on the left pane.
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File | Options Help

M %) View Date/Time
—_—

Onli F Maximum records...

& re G5 Set credentials...

Select the Options View Date/Time menu

Select again the MDBPoint11 table on the left pane. TIMEDATE column now shows
a readable date and time.

=Tk
File Options Help
[w « » n |
| online historical databases / TIMEDATE | sTatE [ vaLUE | B
| @ resultsdb [427] 2013-04-25 15:40:50 531 1 1290
- EF ALARMS [128] 2013-04-25 15:40-52.575 1 1280
EfAUDIT E 2013-04-25 15:40°55 617 1| 3850
~EF EVENTS | 130]2013-04-25 15:40:57 645 1| 6420
- B MDBPoint01 | 131] 2013-04-25 15:41:00.687 1 8990
- EF MDBPoint(2 | 132|2013-04-25 15:41:02.715 1| 11860
~Ef MDBPoint(03 133]2013-04-25 15:41:05.757 1| 14130
- MDBPoint04 [434] 2013-04-25 15:41:07.785 1| 16700
EF MDBPoint05 E 2013-04-25 15:41-10 827 1| 19270
EF MDBPoint06 | 136]2013-04-25 15:41:13.869 1| 21840
- B MDBPoint07 | 137]2013-04-25 15:41:15.681 1| 24410
- B MDBPoint08 | 138]2013-04-25 15:41:17.925 1| 26980
B MDBPoint09 139| 2013-04-25 15:41:20 951 1) 29850
- B MDBPoint10 [940] 2013-04-25 15:41:22.995 1| 32120
IDBPoint11 [941] 2013-04-25 15:41-26.037 1| -30846
Ef MDBPoint12 E 2013-04-25 15:41-28 065 1| -28276
| 143] 2013-04-25 15:41:31.107 1| 25706
| 144] 2013-04-25 15:41:33.135 1| 23136
| 145]2013-04-25 15:41:36.177 1| 20566
146/ 2013-04-25 15:41:38 205 1| 17996
[947] 2013-04-25 15:41:41.247 1| 15426
E 2013-04-25 15:41-44 273 1| 12856
| 149]2013-04-25 15:41:46.317 1| 10286
| [ 150] 2013-04-25 15:41:49.343 1| 7716 -

Query: [select * from MDBPoint11 limit 150;] Number of records fetched: 150 Result ok
0 b 0R

The Options Set credentials menu allows for the setting of user and password of
historical database.

Help menu
Show the online help guide.

Menu of IndigoSCADA 51



Main toolbar of IndigoSCADA

The main toolbar of IndigoSCADA is made up by 10 objects:

Report make

Report configure
Report review

Report print

Report alarm

Report events

Edit batches
Acknowledge all alarms
Help

Clock
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Configuration

Ini files configuration

Edit C:\scada\project\scada.ini in order to configure the default browser.
The browser is used to show help windows and reports produced by the user.
[internet browser]

path=C:\Program Files\Internet Explorer\I[EXPLORE.EXE

In order to enable the recording of protocol communication to log files in
C:\scada\logs, set log to fileto 1

[drivers]
log to file=1

Advanced topics

IndigoSCADA Modbus protocol configuration

IndigoSCADA is using VT _types (used in OPC) to describe the modbus type:
VT_BOOL is a bit

VT _I4 is a 32 bits signed integer

VT _UlIA4 is a 32 bits unsigned integer

VT_R4 is a 32 bits floating point

VT_RASWAP is a 32 bits floating point with swap of words

VT _12 is a 16 bits signed integer

VT _UI2 is a 16 bits unsigned integer

Modbus function codes:

The following modbus functions are used to read:

_FC_READ_COILS 0x01 for IndigoSCADA this is type VT _BOOL
_FC_READ DISCRETE_INPUTS 0x02 for IndigoSCADA this is type VI BOOL

_FC_READ HOLDING_REGISTERS 0x03 for IndigoSCADA this can be type VT 14,
VT R4, VT 12, VT UI4, VT UI2

_FC_READ_INPUT_REGISTERS 0x04 for IndigoSCADA this can be type VT 14,
VT R4, VT 12, VT Ul4, VT UI2

The following modbus functions are used to write:
_FC_WRITE_SINGLE_COIL 0x05 for Indigo this is type VT _BOOL

_FC_WRITE_MULTIPLE_REGISTERS 0x10 for Indigo this can be type VT 14,
VT R4, VT 12

Columns of Data Table in IndigoSCADA Protocol Configurator for Modbus
protocol are used this way:
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MODBUS part:
slave id = ID of the device in daisy-chain
modbus_function read = MODBUS function used to read ITEM

= IndigoSCADA Protocol Configurator - C:fscada/project/ modbus_databasel.db - |EI|£|

File Edit View Help

=2 SN i sl MR

Database Structure | Browse Data IEIBCLI‘[E SaL I

Table: Imndbus_tal::le j @.\| Mew Record Delete Record

slave_id| modbus_function_read | modbus_function_write | modbus_address | modbus_type | ioa_control_center | deadband 2
WT_BOOL
WT_BOOL
WT_BOOL
WT_BOOL
WT_BOOL
WT_BOOL
WT_BOOL
WT_BOOL
WT_l4
0|VT_R4
B5|VT_I2
A3VT_BOOL
0

1

2

tn|tn|n|n|en|n|én|in
S [N | e B R =2

O | =i ||| R —
L | 00 | e | T K| e | R | R —

—
=
—
=

—_
—
—_
—_

—
Ped
—
Pl

—_
[¥E]
—_
(5]

VT_BOOL
VT_BOOL
VT_BOOL 15 |

4| ]
: |1-24af24 > | Go to: ||ﬂ

—_
F=
—_
e

ala|lalmlw|lw|lt|alalalalalalal—a
—
[=1]
—
=

1
1
1
1
1
1
1
1
1
1
1
1
2
2
2

—
wn

modbus_function write = MODBUS function used to write the ITEM
modbus _address = MODBUS address of the ITEM, is an offset relative to the first address
of the function used.

Record one has modbus_address 0, coils function 1 is used, so add the first coils address
(000001) and you get actual modbus address 000001;

Record 11, has modbus address 65, holding registers function 3 is used, so add the first
holding registers address (400001) and you get actual modbus address 400066;

Record 12, has modbus_address 33, discrete inputs function 2 is used, so add the first
discrete inputs address (100001) and you get actual modbus address 100034;

modbus_type = WINDOWS (or OPC) type, used to describe the ITEM type
IEC104 part:

ioa control center = progressive number identifying the ITEM
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10/
File Options Help
lu 4 >N|

Online real time databases NameE [ 7AG |uppe| uppE| Low| Lowd uae uwer Lwe Lagl ReceiPe [enaBieD [10a Params [unT [ 4l
& configdb 1 [MDBPaint01 |VALUE 0 o o o 0 0/ 0]  0[(defaul) 1 MDB
~EFACTIONS 2 i3l \/ALUE 0 o o o 0 0/ 0 0f(defaul) 1 MDB
- ALARMGROUP 3 K \VALUE 0 o o o 0 0/ 0 0f(defaul) 1B MDB
~EFBATCH 4 Rl \VALUE 0 o o o 0 0/ 0 0f(defaul) 1B MDB
~EPPROPS 5 gl ALUE 0 o o o 0 0/ 0 0f(defaul) 18 MDB
-~EFRECEIPE 6 il VALUE 0 o o o 0 0/ 0 0f(defaul) 1 MDB
-EFREPORTS 7 il v ALUE 0 o o o 0 0/ 0 0f(defaul) 1 MDB
- SAMPLE 8 il VALUE 0 o o o 0 0/ 0 0|(defaul) 1 s MDB
- SCHEDULE 9 iER VALUE 0 o o o 0 0/ 0 0f(defaul) B MDB
- SERIAL 10 i vALUE 0 o o o 0 0/ 0 0f(defaul) 1R MDB
11 VALUE 0 ol o0 0 0 0 0/ 0|(default) 1 EE MDB
~EPUNITS 12 VALUE 0 o o o 0 0/ 0 0f(defaul) 1EH MDB
-EFUSERS 13 VALUE 0 o o o 0 0/ 0 0f(defaul) 1B MDB
& currentdb 14 VALUE 0 o o o 0 0/ 0 0f(default) 1 MDB
& resultsdb 15 VALUE 0 o o o 0 0/ 0 0f(defaul) 18 MDB
16 VALUE 0 o o o 0 0/ 0 0f(defaul) 1EE MDB
17 VALUE ol o o o o o of odefaul) 1 VDB
18 VALUE 0 of o o o o 0f o0fdefaul) 1 MDB
19 VALUE 0 o o o 0 0/ 0 0f(defaul) 1 EE MDB
20 i \/ALUE 0 ol o0 0 0 0 0/ 0f(default) 1Y MDB

21 VALUE 0 o o o 0 0/ 0 0f(defaul) 1 MDB =
2 VALUE 0 0f o o o o 0f o0f(defaul) 1 VDB
23 VALUE 0 of of o o o of of(defaul) 1 VDB

q | | EX VALUE 0 o o o 0 0/ 0 0f(defauly) 1 MDB =l

28 Result ok

The relation between modbus table and TAGS table of configdb database is done by

ioa control center column on modbus table and IOA column on TAGS table, so for example

MDBPoint11 has IOA 11and through modbus table has modbus type VT 12,
modbus_address 65, modbus_function read 3.

If you need another modbus unit (line 2), create for example a unit with name MDB2 and

make a copy of file C:\scada\project\imodbus_databasel.db and rename the copy as
C:\scada\project\modbus_database2.db Configure the unit and restart the monitor.

MODBUS TCP address 127.0.0.1 PO

modbus_read_registers: get h1t 1% from word: value = 1
bit 14 from word: value
hit 13 from v value
bit 12 from w value
hit 11 from v value
bit 18 from w value
bhit from u value
bit from w value
bhit from u value
bit from w value
bhit from u value
bit from w value
bhit from u value
bhit from w value
bhit from value
bhit from value

[12][E5][BE][BB][BE][EE][Bi][ﬂi][ﬂﬂ][ﬂﬂ][ﬂﬂ][ﬂi]

Waiting for a confirmation...

<12 ><E5>{08><{B8>{08><B84>{01 ><@1 >{P81 ><{B8a >

modbus_read_bits: value = @

[1Z21[E6]1[BAIIBAII[OAII661[01 1[61 1[0A1[61 1[681LH1 1

Waiting for a confirmation...

<12 ><E6>{88><{88>{08>{84>{01 ><@1 ><{81 ><{Baa>

modbus_read_bitsz: value = @

TR TR - P -
Wwwnnn
L

Advanced topics
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Advanced topics

IndigoSCADA OPC DA protocol configuration
Step 1:

Browsing of available OPC DA itemID's in the server

Open a command shell windows and run the command, that will create the file
configuration file.sql in C:\scada\project:

opc_client_da.exe -a server_IP_address -p OPCServerProgID -e configuration_file.sql -q {CLSID}

Example:

opc_client_da.exe -a 10.15.20.30 -p Enscada.OPC.Srv -e configuration_file.sql -q {78BB6572-B8BA-
47F9-83B3-4EC99DF9B1A3}

Step 2:

Creation of protocol configuration database

Go to C:\scada\bin and run protocol configurator.exe

Import the C:\scada\project\configuration file.sql, selecting the

g 1:(\ascada\project\configuration_fﬂe.sql with the menu: File->Import->Database from SQL
At the question: Do you want to create a new database file to hold the imported data?
Answer: Yes

The database name should be your OPCServerProgID with extension .db

Save it in C:\scada\project

If you do not use OPCServerProgID.db name, the Step 3 will fail.

Example: Enscada.OPC.Srv.db

Wait for few seconds the Import Completed confirmation Window

Step 3:

Creation of the new SCADA points
1 - Select the menu: Configure\Configure Units
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= [Non-Commercial] - IndigoSCADA Client

Eile Reports | Configure System Caontrol Help

JJE m E “=) Configure System. .

HI | Alarm
g

Sim Configure Sample Points...

Configure Users. ..

10: u Configure Scheduled Events. ..

u Configure Alarm Groups...

SimAdc0s
95.45V

SimCounts01
60.71 Micuit

2 - Press button New

Unit Configuration

SimAdc0B
9423V

SimCounts02
967.23 MNicuft

Marne Sim

Comment Analogici e contatori

Type Simulataor

IV Unit Enabled

M e, Delete. .

Apply

Configure. ..

Help Exit

3 - Fill in the edit field Name: OPC

Advanced topics
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=% [Non-Commercial] - New Item x|
Mame oPC
Ok Help Cancel

4 - Select Type opc_client da_driver, flag Unit Enabled and press Configure button

[Hon-Commercial] - Unit Configuration

Name OPC j

Comment (***)

Type

¥ Unit Enabled Configure. .. |

Apply Mew. . Delete. .. Help | Exit |

5 - Fill in the OPC Server ProgID, OPC Server IP address, OPC Server Class ID, number
of Items and Update Interval in milliseconds. If IP address is left empty, local OPC DA

server is used.
If OPC Server Class ID is left empty, it is necessary to configure opcenum.exe on the OPC

server host.
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[Mon-Commercial] - Opc_client_da Configuration

MName oPC

OPC Server ProglD Enscada OPC S

OPC Server IP address 10.15.20.30

OPC Server Class 1D {T8BBBAT2-BEBA-4Tf9-53B3-4ECI9DFIB"

N ltems 20 i’
Y
Update Interval (ms) 1000 37

Ok | Help | Cancel

6 - Press button Apply and wait that the Apply button returns active and then press Exit

[Mon-Commercial] - Unit Configuration

Name oPC j

Comment  |(***)

Type

I+ Unit Enabled Configure. .. |

Apply Mew. . Delete. .. Help | Exit |

7 - Restart monitor.exe
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= [Mon-Commercial] - IndigoSCADA Client

Eile Reports Qmﬁg.nrelSystem Control Help

DR ES

HMI | Alarms | §tatus,ﬁ Real time database management...
@] Historical database management...

Step 4:

Configure each sample point

8 - Select the menu: Configure\Configure Sample Points

= [Mon-Commercial] - IndigoSCADA Client
File Reports | Configure System Control Help

“ﬂ W E “=) Configure System. .

HMIlﬂam

@7 Configure Users. .
@ Configure Units...
Configure Sample Points
LY Configure Scheduled Events. .

. Configure Alarm Groups...

9 - Set Comment, Type, Units and the limits of each new point. Press button Apply
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Point Number 01
Point Number 02 Paint Number 08
Point Number 03
Point Number 04

Point Number 06
Point Number 07 M_ME_TF 1
Point Number 08

kl Point Number 09

Point Number 11

Point Number 12

Point Number 13
Point Number 14
Point Number 15
Point Number 16
Point Number 17
Point Number 18
Point Number 19
Point Number 20
Point Number 21
Point Number 22
Point Number 23
Point Number 24

- Set type M_SP TB 1 for digital OPC point (i.e VI BOOL OPC type or any scada point
that evaluate to 0 and 1)

- Set type M_ME TF 1 for analog OPC point

Step 5:

HMI configuration with HMI designer
10 - Run the process C:\scada\bin\hmi designer.exe

11 - Open the XML designer file C:\scada\project\hmiO.ui
11.1 - Or create from scratch your HMI (dialog) and save it as hmiO.ui in C:\scada\project

12 - Use the following widget classes
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Widget Class
SINGLE POINT LED PSinglePointLed
DOUBLE POINT LED PDoublePointLed
SINGLE POINT LED SinglePointLed

DOUBLE POINT LED DoublePointLed

SWITCH PSwitch
THERMOMETER QwtThermo
LCD NUMBER PLCDNumber

COMMAND BUTTON QPushButton

TANK PTank
THERMOMETER PThermometer
EDIT FIELD QLineEdit
BREAKER Breaker
DOUBLEBREAKER DoubleBreaker
PLOT QwtPlot
METER Pmeter

13 - Widget names must contain the underscore as separator between sample point
SCADA name and widget ID

For example the widget with SCADA name OPCPoint09 and widget ID 10 has full name:
OPCPoint09 10

Please see next image 1
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= [Non-Commercial] - IndigoSCADA HMI designer - |EI|1|
File Edit Project Search Tools Layout Preview Window Help
- o — : 1=
D Q& orrs oy [ KDE @ 8w = 8w D ek eSS
— T — ] -
Common Widgets e Froperties ISigna_IHandIers |
Buttors : -
<Mo Project:> ;I
7 N OPCPoint09 -
Containers - g : : HMI_manager: C:/scada/M apshmi.ui LIS |OPCPaint03_10 &
Views ™, DoublePointLe - = =
Datobass 1 ol [ CescadasMaps/hmivik = 530, 230, 81, 60
N T
i 0.8 g ¥ . 280, B0,
Input e E sizePolicy Freferred/Preferred...
Display ™, : mirimumSize [0.0]
SCADA Widgets ~ s maximumSize [ 32767, 32767 ]
G\ Dial = D'E paletteForegroun...
LI paletteB ackgrou...
e —
If_\. Plot o e = paletteBackgrou...
Q—%Analogﬁlock jEcts IMembers | \ palette — l - — l
backgroundQrigin [\WidgetQrigin
ElPushButton Mame l Clazz ;I font M5 Shell DIg-2
3 scae Q) OFCFaint0g_1 RDaublePaintLed cusor[Awow
© SingeFoitted - Jme|OPCPaintis_13 u\tpushauuon mouseTracking  |Fakse
focuzPolicy StrongFocus
= - [ orcronos_14 PLCDNumber
n FTank I- acceptDrops False
© PooubiPoiLed -] OPCPaioa_15 QuiThemo switchivae  |Fabe
;i — | @ OPCPoint03_16 PTanA Onlabel an
i m OFCPoini13_3 FTank ifCabel o
B [ toolTi
@ Fiee OPCPointt 3.6 AwtThbmo & toollie
= whatsThis
feXt Knab OPCPaint13_7 FThemyometer
coume, () OPCPoint03_1 PSinglgPoint_ed
OD HePointLed |28 OPCPointd3_11 PSwit
oublePointLe
) OFCFaint33_4 PDouﬂuIePointLec
[T wiheel ) OFCFaint33_2 PSindlePointLed
ef= Slder ----ODPEPoint45_1 PSirﬁIePointLed
[me]arcroinns 4 OufPushButon
PLCDMumnber
E ----IEDPEPoint‘I 322 ?{EDNumber
& Pswitch OPCPoint03.50 /|OLinekdt
PToggl
f Pleage @ oPcPana e /) |aLineEdt = e
Custom widgets ™, LI _’I = - J

14 - To enable the inspect popup window, please follow the procedure:

You have to connect the signals RightClicked(QString&,QString&) of the widgets with the
slot RightClicked(QString&,QString&) of the HMI dialog (here Form1)
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=" [Non-Commerdcial] - IndigoSCADA HMI designer
File Edit Project Search Tools Layout Preview Window Help

==l x|

D Q@[O0 |6 mE 8w E D e

*
o o — | ———————

K| PushButton
(@ RadioButton

i ChechkBox

ButtonGroup
ListBox
LineEdit
@ SpinBox
[51] TextEdk
ComboBaox
T TextLabel
[l Spacer

Comanes | &
Views ™ [
Database N[ o]
Input ™,

Display ,
SCADA Widgets ™

| P o e Y | P L W W Y | P W W W WY
Custom Widgets ™, LI

w3 N

QFrame

line

=

./\_ x| x|
Properties ISignaI_ He 4| »
<No ij...;l Property |\.ra|._.e B
Dan._ name [Foml &
enabled |True
sizePolicy| Prefemed;/ ..
minimu... |[0,0]
madmu...|[ 32767, 3...
sizelner...|[0, 0]
baseSize |[0.0]
LI paletteF. ]:
x| palstte... [ 1]
= palette. ..
e I A2 palette || ]
Nam{ Class |+ backar... |WidgetOn...
=] FQDialog font MS Shell
W aLabel cursor  |Cross
ion |Fom1
-{aLabel icon
[_]..[QF,B,T,E icon Text
PSwitch mouseT..|False
focusP... [NoFocus
§ PLCD.. accept... |False
| § PTank sizeGrip..| False
[N aLabel modal  |Falss
-[QaLabel Fooliiy
whats Thig
EI--[Omee
PLCD...
Doubl...
Single...
PLCD...

[Ready

" [Non-Commercial] - View and Edit Connections

Connections:

Sender Signal Receiver Slot
a SimDig04_pl CDNumberS

Delete

Edit Slots

:
Edi |

x|
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%" [Non-Commercial] - View and Edit Connections 2lxl

Connections:

Sender
a SimDig04_plCDNumber5

Signal New

<Mo Signal: hd

Delete

<Mo Signal
' RightClicked|(Q String& Q String&)
Edit Slots...

i

< [Men-Commercial] - View and Edit Connections ﬂﬂ
Connections:
Sender New
a SimDig04_pLCDNumber5 RightClicked(QString®.QString&)

Press "Edit Slots..."

Cancel

o |
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=" [Non-Commercial] - Edit Functions 21

Function / | Retum Type | Specifier | Access Type In Use

v Only display slots . - . Mew Function | J Delete Function
Press "New Function button = ' = |

Function Properties

Function: I Betum type: I':.ru::id
Speciier: I'u'irtual vI Access: Ipublin:: vI Type: | slot ¥

Help oK Cancel
b
=" [Mon-Commercial] - Edit Functions 7| x|
Function | Retum Type | Specifier | Access Type In Use
SII new Slat() void virtual public glot Mo
[+ Only display slots Mew Function | Delete Function |

Rename "newsSlot() to "RightClicked(Q5tring& QString &)
Function Properties

Function: | =i Betum type: I'l.rnid
Specifier: I':.rirtual TI Access: | public »| Type: |slot -

Help oK Cancel
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= [Mon-Commercial] - Edit Functions

o

Function / I Retum Type Specifier Access Type In Use |

&a Right Clicked (2 5ting&, G String&) void wirtual public slot MNa

¥ Only display slots Mew Function | Delete Function |
Function Properties
Function: Ingl'rtDicked{QString&.QString&} Betum type: I'u'c:id
Specifier: I virtual vI Access: | public | Type: |slot -

Help OK Cancsl
4
=% [Non-Commercial] - View and Edit Connections 2x]
Connections:
Sender New |

a SimDig04_pl CDNumberS

RightClicked(Q String® QStringd) Form1
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= [Non-Commerdial] - View and Edit Connections

Connections:

Receiver

Cancel |

£ [Non-Commercial] - View and Edit Connections

Connections:

(((((((((((((((l

SimAdc03_pLCDNumber2
SimAdc04_pl CONumberi
SimAdc02_wt Thermo 1
SimDig03_pDoublePointLed 1
SimDigl4_pSinglePointLed1
SimDigl7_pSwitch1
SimAdc02_pLCDMNumberg
SimDigl4_pLCDMNumbers
SimDig03_pLCDMNumberd
SimDigl1_pLCDMNumbers
SimDigl2_pLCDMNumber?
SimDigl7_pLCDMNumber3
SimAdc1_wtPushButton

RightClicked{QString&. G Stringd)
RightClicked (2 Sting&, Q String &)
RightClicked (2 Sting&, Q String &)
RightClicked (2 Sting&, Q String &)
RightClicked{QString&, 3 String&)
RightClicked{QString&, 3 String&)
RightClicked{QString&, G String&)
RightClicked{Q String&, Q1 String&)
RightClicked{Q String&, Q1 String&)
RightClicked{Q.5tring#. Q.5tringé)
RightClicked{Q5tring#. G Stringd)
RightClicked{Q5tring#. G Stringd)
RightClicked{QString&. G Stringd)
pressed|)

Form1
Form1
Form1
Fom1
Fom1
Form1
Form1
Form1
Form1
Form1
Form1
Form1

Form1

RightCl

RightClicked |G String &G String &)
RightClicked (2 5tring &G String &)
RightClicked (2 5tring &G String &)
RightClicked (2 5tring &G String &)
RightClicked|Q5tring&, Q1 String &)
RightClicked|Q5tring&, Q1 String &)
RightClicked|QString&, G 5tring &)
RightClicked|QString&, Q1 String &)
RightClicked|QString&, Q1 String &)
RightClicked|QString &, Q5tring&)
RightClicked|QString & QString &)
RightClicked|QString & QString &)
RightClicked |G String &G String &)

sendCommand()

Cancel
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=5 [Non-Commercial] - IndigoSCADA Client

File Reports Configure System Control Help

==l x|
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Advanced topics

Configuration of IndigoSCADA as loT gateway
IndigoSCADA supports MQTT/Sparkplug B as payload encoding.

Open file C:\scada\project\manager.ini. Add the following section to activate MQTT
client publisher for sending messages to broker broker.hivemq.com:

[Process6]

Process = mqtt_client_publisher.exe -a broker.hivemqg.com -p MIA_Command/# -l 1 -t 1883
PauseStart= 1000

PauseEnd= 1000

Userlnterface = Yes

Restart = Yes

Open file broker.hivemqg.com publisher.db with protocol configurator.exe and
configure each ioa_control center for every mqtt topic.

ioa_control center has to match with the one of input protocol, eg. modbus

= IndigosCADA Protocol Configurator - C:fscada/project/broker hivemg.com_publisher: - |EI|£|

File Edit View Help

0@ m e BN

Database Structurs | Browse Data IExecute SaL I

Table: Imqﬂ_u:lient_table | %I New Record | Delete Record
matt_topic matt_command_topic ioa_control_center | iec_type readable w2
1 MIA_Temp/Temp_ude MIA_Command/Temp_ude 1/M_ME_TF_1 1
2 MIA_Temp/Temp_udestue |MIA_Command/Temp_udestue 2IM_ME_TF_1 1
3 MIA_Temp/Temp_save MIA_Command/Temp_sove JM_ME_TF 1 1
4 MIA_Temp/Temp_stue MIA_Command/Temp_stue 4/M_ME_TF_1 1
5 MIA_Temp/Temp_koeklken|MIA_Command/Temp_koekken BM_ME_TF_1 1
6 MIA_Temp./Maaler MIA_Command/Maaler 6/M_ME_TF_1 1
7 MIA_Temp/Efekt MIA_Command/Effekt 7/M_ME_TF_1 1
8 MIA_Temp/b MIA_Command/b B/M_ME_TF_1 1
9 MIA_Temp.c MIA_Command/c S/M_ME_TF_1 1
10 |MIA_Temp/d MIA_Command.d 10{M_ME_TF_1 1
11 |MIA_Tempie MIA_Command/e T1/M_ME_TF_1 1
12 |MIA_TempAf MIA_Command.f 12{M_ME_TF_1 1
13 |MIA_Tempig MIA_Commands/g 13|M_ME_TF_1 1
14 |MIA_Temp/h MIA_Command/h 14{M_ME_TF_1 1
15 |MIA_Temp/i MIA_Command.i 15({M_ME_TF_1 1 LI
1| | 2l

; |‘I-24of24 . | Go to: ||ﬂ—
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Support

For questions about IndigoSCADA, please email your request to the following e-mail
or use the forum at Sourceforge site.

E-MAIL: info at enscada.com

SITE: https://sourceforge.net/projects/indigoscada/

SITE: https://www.enscada.com/a7khg9/indigoscada.html
FORUM: https://sourceforge.net/p/indigoscada/discussion/users/
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